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DEPARTMENT OF MECHANICAL ENGINEERING

VISION

To be a reputed centre of excellence in the field of mechanical engineering by
synergizing innovative technologies and research for the progress of society.

MISSION
« To impart quality education by means of state-of-the-art infrastructure.

- Toinvolveintrainings and activities on leadership qualities and social
responsibilities.

« To inculcate the habit of life-long learning, practice professional ethics and
service the society.

« To establish industry-institute interaction for stake holder development.



DEPARTMENT OF MECHANICAL ENGINEERING

After 3-5 years of graduation, the graduates will be able to:

PEO1: Excel as engineers with technical skills, and work with complex
engineering systems.

PEO2: Capable to be entrepreneurs, work on global issues, and contribute
to industry and society through service activities and/or professional
organizations.

PEO3: Lead and engage diverse teams with effective communication and
managerial skills.

PEO4: Develop commitment to pursue life-long learning in the chosen
profession and/or progress towards anadvanced degree



DEPARTMENT OF MECHANICAL ENGINEERING

PROGRAM OUTCOMES
Engineering Graduates will be able to:

Pol. Engineering knowledge: Apply the basic knowledge of mathematics, science
and engineering fund a mentals along with the specialized knowledge of mechanical
engineeringtounderstand complex engineering problems.

PO2. Problem analysis: Identify, formulate, design and analyse complex
mechanical engineering problems using knowledge of science and engineering.

Po3. Design/development of solutions: Develop solutions for complex
engineering problems, design and develop system components or processes that
meet the specified needs with appropriate consideration of the public health and
safety, and the cultural, societal, and environmental considerations.

PO4. Conduct investigations of complex problems: Formulate engineering
problems, conduct investigations and solve using research-based knowledge.
PO5. Modern tool usage: Use the modern engineering skills, techniques and tools
that include IT tools necessary for mechanical engineering practice.
Po6.Theengineerandsociety: Apply the contextual knowledge to assess societal,
health, safety, legal and cultural issues and the consequent responsibilities relevant to
the professional engineering practice.

PO7. Environment and sustainability: Understand the impact of the professional
engineering solutions in societal and environmental contexts, and demonstrate the
knowledge of,and needfor sustainable development.

POS8. Ethics: Apply ethical principles and commit to professional ethics and
responsibilities during professional practice.

PO9. Individual and team work: Function effectively as an individual, and as a
member or leader in diverse teams, and in multidisciplinary settings.
PO10.Communication: Communicate effectively on complex engineering activities
to various groups, ability to write effective reports and make effective presentations.
PO11. Project management and finance: Demonstrate and apply the knowledge
to understand the management principles and financial aspects in multidisciplinary
environments.

PO12. Life-long learning: Recognize the need for, and have the preparation and
ability to engageinIndependent and life-long learning in the broadest context of
technological change.

PROGRAM SPECIFIC OUTCOMES

Mechanical Engineering Graduates will be able to:

Pso1: Apply the knowledge of CAD/CAM/CAE tools to analyse, design and develop
the productsandprocessesrelated toMechanical Engineering.

PSO 2: Solve problems related to mechanical systems by applying the principles of
modern manufacturing technologies.

PSO 3: Exhibit the knowledge and skill relevant to HVAC and IC Engines.
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CODE OF CONDUCT
Students should report to the concerned labs as per the time table schedule.

Students who turn up late to the labs will in no case be permitted to perform the
experiment scheduled for the day.

After completion of the experiment, certification of the concerned staff in-charge
in the observation book is necessary.

Staff member in-charge shall award marks based on continuous evaluation for each
experiment out of maximum 15 marks and should be entered in the evaluation
sheet/attendance register.

Students should bring a note book of about 100 pages and should enter the
readings/observationsintothenotebookwhileperformingtheexperiment.

The record of observations along with the detailed experimental procedure of the
experiment performed in the immediate last session should be submitted and certified by
the staff member in-charge.

Not more than three students in a group are permitted to perform the experiment on
a setup for conventional labs and one student in case of computer labs.

The components required pertaining to the experiment should be collected from stores
in-charge after duly filling in the requisition form.

When the experiment is completed, students should disconnect the setup made by them,
and should return allthe components/instruments taken for the purpose.

Any damage of the equipment or burn-out of components will be viewed seriously either
by putting penalty or by dismissing the total group of students from the lab for the
semester/year.

Students should be presentin the labs for the total scheduled duration.

Students are required to prepare thoroughly to perform the experiment before coming to
Laboratory.



DO’S
1. Leave footwear & bag outside the laboratory at their designated place.
2. Enter the system number in the register & use the system alone.

3. Report any broken plugs, exposed electrical wires or any unsafe conditions to your
lecturer/laboratory staffimmediately.

4. Read and understand the procedure from Lab Manual as how to carry out an activity
thoroughly before coming tothe laboratory.

Always keep anti-virus in active mode
Studentsmust carrytheirldentity Cards & Observation NotesinthelLab.

Enter or Leave the lab only with the permission ofthe lab in charge.

© N o u

Turn off the respective system and arrange the chairs properly before leaving the
laboratory.

DON'TS

—

Do notinstall, uninstall or alter any software on computer.

Do not touch electrical fittings nor connect or disconnect any plug or cable.

Do not plug in external drives like pen drive, external hard disk or mobile phone
Students are not allowed to work in the Lab without the presence of faculty or instructor.
Do not leave your place, misbehave or make noise while in the Lab.

Don’t scatter around unwanted things while doing an experiment.

N o u kW DN

Do not eatordrink in the laboratory.



COURSE OBIJECTIVES
The objective of this course is

1. | Understand fundamentals of the analysis software, its features and applications.

Learn the basic element types in Finite Element analysis.

2
3. | Know the concept of discretization of continuum loading conditions.
4. | Analyze the structure using pre-processor and post-processor conditions.

COURSE OUTCOMES

co Course Outcomes PO
No.

CO 1 |Determine Stress, Strains and deflections under static, thermal and | 1,2,3,5,8,9,10,12
combined loading.

CO 2 |Analyse Plane stress, plane strain conditions & axi-symmetric 1,2,5,8,9,10,12
loading on plane members to predict the failure behavior.

CO 3 |Analyse component with tetrahedron and brick elements. 1,2,3,5,8,9,10,12

CO 4 | Predict the natural frequencies and modes shapes using Modal 1,2,3,5,8,9,10,12

and Harmonic analysis.

CO 5 |Simulate steady state heat transfer analysis of chimney, Transient| 1,2,3,5,8,9,10,12
heat transfer of casting.

COURSE OUTCOMES VS POs MAPPING

SNO PO1 | PO2 | PO3 | PO4 | PO5 | PO PO7 |PO8 |PO9 (PO10|PO11| PO12 PSO1|PSO2|PSO3

6PC760ME.1 | 3.0| 3.0] 3.0] 3.0| 1.0| -| - | 1.0|1.0| 1.0] - | 1.0] 3.0
6PC760ME.2 | 30| 3.0/ - | 3.0| 1.0| -| - | 1.0|1.0] 1.0| - | 1.0] 3.0
6PC760ME3 | 3 0| 3.0{ 3.0| 3.0| 1.0 -| - | 1.0]1.0] 1.0| - | 1.0| 3.0
6PC760ME.4 | 3.0 | 3.0] 3.0/ 3.0/ 1.0| -| - |1.0lt.0] 1.0| - | 1.0] 3.0
6PC760ME.5 | 3.0 | 3.0] 3.0/ 3.0/ 1.0| -| - |1.0[1.0l 1.0] - | 1.0] 3.0

Avg 3.0 3.0 3.0/ 3.0 1.0} - - 110/1.0{ 1.0 - | 1.0] 3.0
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Methodist College of Engineering & Technology
Department of Mechanical Engineering

Introduction to Ansys

Description:

The ANSYS Workbench environment is an intuitive up-front finite element analysis tool that
is used in conjunction with CAD systems and/or Design Modeler. ANSYS Workbench is a
software environment for performing structural, thermal, and electromagnetic analyses. The
class focuses on geometry creation and optimization, attaching existing geometry, setting up
the finite element model, solving, and reviewing results. The class will describe how to use
the code as well as basic finite element simulation concepts and results interpretation.

Steps in Ansys Workbench:

e Workbench GUI
e Engineering Data
e Design Modeler

e Geometry
e Model

e Meshing
e Setup

e Solution

e Result

Workbench GUI

Introduction This document serves as a step-by-step guide for conducting a Finite Element
Analysis (FEA) using ANSYS Workbench. It will cover the use of the simulation package
through the graphical user interface (GUI). More advanced topics will also be briefly covered.

Aims and Obijectives

The purpose of this document is to provide step-by-step instructions on how to use ANSYS
Workbench through the GUI. Upon completion, the student should be able to:

« use symmetry conditions to simplify a typical engineering problem
« perform a finite element simulation of a typical engineering problem

« investigate the effects of certain variables that are changed

Launch Ansys Workbench:

Launching ANSYS Workbench the ANSYSS installation has many packages included. For this
tutorial, we will be using ANSYS Workbench.
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Engineering Data:
A part’s response is determined by the material properties assigned to the part.

o Depending on the application, material properties can be linear or nonlinear, as
well as temperature-dependent.

o Linear material properties can be constant or temperature - dependent, and
isotropic or orthotropic.

o Non linear material properties are usually tabular data, such as plasticity data
(stress-strain curves for different hardening laws), hyper elastic material data.

o To define temperature - dependent material properties, you must input data to
define a property - versus - temperature graph.

o Although you can define material properties separately for each analysis, you
have the option of adding your materials to a material library by using the
Engineering Data tab. This enables quick access to and re-use of material data
in multiple analyses.

o For all orthotropic material properties, by default, the Global Coordinate System
is used when you apply properties to apart in the Mechanical application. If
desired, you can also apply a local coordinate system to the part.

To manage materials, right-click on the Engineering Data cell in the analysis system
schematic and choose Edit.

Geometry:

All analysis systems and several component systems, including Geometry, Meshing, and
Mechanical Model, begin with a geometry-definition step. You can define the geometry
differently depending on the type of simulation you are running. In most cases, you will use
the Geometry cell. Via the Geometry cell, you can:

o Create a geometry from scratch in Design Modeler
o Import an existing geometry:
o From neutral formats like IGES, STEP, Para solid, ACIS
o From CAD files on disk
o From an active CAD session that is already running on
the same machine

For Fluid Flow simulations, you can also start with an imported mesh or case file; see Basic
Fluid Flow Analysis, Starting from an Imported Mesh for details.

Specifying Geometry via the Context Menu

1. Right-click the Geometry cell.

2. Choose New Geometry to launch Design Modeler and create a
new model, or choose Import Geometry and browse to an existing
CAD model.
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Alternatively, you can also launch ANSYS Workbench directly from some CAD systems.
When doing so, ANSYS Workbench starts with a Geometry system in place and the CAD file
already attached.

After you have attached or imported your geometry, the state appears as Up to Date, and the
icon indicates the type of file imported.

If you do not need to make any additional changes to your geometry, you can continue
working through the analysis as described in the next sections.

If your geometry needs to be modified before continuing with your analysis, you can edit the
geometry in Design Modeler. After modifying the geometry in Design Modeler or importing a
Design Modeler file, the icon in the Geometry cell will change to a Design Modeler icon. For
a file imported and then modified in Design Modeler, you can open the file in Design
Modeler, and the Design Modeler model tree will indicate the original source of geometry.

After the geometry is defined, you can share it with other systems. See Data Sharing and Data
Transfer for more information on sharing geometry systems.

Model / Mesh:

ANSYS Twin Builder is a powerful platform for modelling, simulating and analysing virtual
systems prototypes. It enables product development teams to verify and optimize performance
of their software-controlled, multi domain systems designs.

The Model cell in the Mechanical application analysis systems or the Mechanical Model
component system is associated with the Model branch in the Mechanical application and
affects the definition of the geometry, coordinate systems, connections and mesh branches of
the model definition.

When linking two systems, you cannot create a share between the Model cells of two
established systems. You can generate a second system that is linked at the Model cell of the
first system, but you cannot add a share after the second system has been created. Likewise,
you cannot delete a link between the Model cells of two systems.

The Mesh cell in Fluid Flow analysis systems or the Mesh component system is used to create
a mesh using the Meshing application. It can also be used to import an existing mesh file.

Edit

Launches the appropriate Model or Mesh application (the Mechanical
application, Meshing, and so on.)

Setup:

Use the Setup cell to launch the appropriate application for that system. You will define your
loads, boundary conditions, and otherwise configure your analysis in the application. The data
from the application will then be incorporated in the project in ANSYS Workbench, including
connections between systems.
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For the Mechanical application systems, you will see the following Setup options, in addition
to the common options:

Edit
Launches the Mechanical application with the geometry loaded and with cells mapped
to their respective tree locations in the Mechanical application.
For CFX systems, you will see the following Setup options, in addition to the common options:
Edit
Launches CFX-Pre.

Import Case

Imports an existing case file containing physics data, region and mesh information for
your analysis.

For Fluent systems, you will see the following Setup options, in addition to the common
options:

Edit

Launches ANSYS Fluent.
Import Case

Imports an existing Fluent case file.
Solution:
From the Solution cell, you can access the Solution branch of your application, and you can
share solution data with other downstream systems (for instance, you can specify the solution
from one analysis as input conditions to another analysis). If you have an analysis running as
a remote process, you will see the Solution cell in a pending state until the remote process
completes. See the discussion on Understanding Cell States, below.
For the Mechanical application systems, you will see the following Setup options, in addition
to the common options described earlier:
Edit

Launches the Mechanical application open to the Solution branch.
Delete

Deletes the Solution and Results cell. Deleting the solution cell makes the system a

setup-only system, meaning the system will generate only an input file. It will not
solve
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or post results. The Solution object and below are removed from the
Mechanical application tree.

For CFX systems, you will see the following Solution options, in addition to
the common options:

Edit
Launches CFX-Solver Manager.

Import Solution
Displays the most recent CFX-Solver Results files imported (if any)
and enables you to browse for such files using the Open dialog box,
where you can specify the CFX- Solver Results file to load. When

the results file is loaded, the system will display only the Solution
cell and the Results cell.

Display Monitors

Opens the ANSYS CFX-Solver Manager and shows the results of the previous
run.

For Fluent systems, you will see the following Solution options, in addition
to the common options:

Edit
Launches ANSYS Fluent.

Import Final Data
Enables you to select an existing Fluent data set (for example, one
solved on an external cluster) into a Solution cell in a Fluent system
and immediately start post-processing in CFD-Post, without the need

to run the minimum of one more solver iteration. This option
becomes available after importing case file into the Setup cell.

Results:

The Results cell indicates the availability and status of the analys is results
(commonly referred to as post processing). From the Results cell, you cannot
share data with any other system.
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EXPERIMENT -01

3D BEAM ANALYSIS WITH DIFFERENT CROSS SECTIONS, SAME
MATERIALS FOR SAME LOADS

AIM:

To Determine the Total Deflection and VVon Misses Stress of various 3 Dimensional
Beam.

SOFTWARE: ANSYS

THEORY:

Consider For different Section as Shown in Figure having Young’s Modulus Of Elasticity of
N
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Calculate and Compare the deflection and VVon Mess Stress.
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Step 2 -Updating Material Properties

Right Click Update Geometry-Update Model — By Default Ansys will Provide Steel
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{5 solution Information

Detaits of “Multiple Selection” R i=E1
-~ Scope
Scoping Method | Geometry Selection 0000 0030 0060(m) .
I W— )
Tedge

Geometry
= Definition

Type Force

Detine By Components ok

Applied By Surtace Effect

Coordinate System Global Coordinate System | raeiees® FIED) o o 100.
XComponent O.N (ramped) pensopussas e T -
YComponent 0N (ramped) et
ZComponent 100N (ramped) —Fha

Suppressed No

v 3 0OX  Tobuler Data ~30Ox
1. |steps |Time 9 |7 x 04 |7 ¥4 | 200
i o -0 -0 -0

Step 5 -Solution -Total Deformation -Von Misses stress

e Total Deformation
e Equivalent Stress
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RESULT & CONCLUSIONS:
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VIVA QUESTIONS:

» Differentiate Between Beam vs Bar ?

What is the physical Significance of Young’s modulus of Elasticity ?
What is the full form of ANSYS?

What are the basic steps for Analysis ?

Differentiate between Meshing and Nodes ?

What do you mean by Boundary Conditions?

Define Factor of Safety ?

How can you validate your design using F.E.A Results ?

Define Modulus of Rigidity ?

Solid vs Hollow Shaft which has more load bearing capacity ?

YV V.V V V V V VYV VY
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EXPERIMENT - 02
1D, 2D AND 3D MESHING OF CANTILEVER BEAM

AlM:

1D, 2D and 3D meshing with different element sizes for different CAD geometry

SOFTWARE: ANSYS

THEORY:
Calculate 1D, 2D and 3D Mesh For The Given Below Geometry
1D Mesh
REVEION HISTORT
NOTES: e e o
00nn
- F+
|
b | cw v | ]
FAATS LSt
INIT | apeRcwacs | DWTE T | APFROVALS |nate
T RS Expatinen 12,10 Hesk
@ €1 ==l==p e -
APPLICATIGN =3 T | el
3
2D Mesh
- REWEION HIETORY
oTES: DESCRETOR mOOAPEY  DAE CHEDKID
f
Smm
l
5 ima
RE -
I
brrheer] o | S e | i ickaten
FARTE LET
- — INIT | gpprevars |Dame ot | APPROVALS |pate
@ % “'""'i” o T EB:! r:lu'.ﬂa: rmc.l.r Y
AFPLICATION Gk I | 2
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3D Mesh

Methodist College of Engineering & Technology
Department of Mechanical Engineering

Lv]
RENIEIDN HISTORY
ey cemnPTn ]
NOTES: — e
ALLL]
— e
120mm
100
-
Vi —— s ST v | 8 b
. PRATS LIST
vt | apemonas |oaTE | i | APPROVALS [nare
T TERIT
T
T
TG ARG PRDECTIR ERET
@ G TE [t GooE r_-—,-o I,.=_.
Ll T T
AFPLICATICN L3 I —

PROCEDURE:
Step 1 1D meshing
Click Static Structural Geometry

File View Tools
@BB!S
=R

Units  Extensions

H Project

Jobs  Help

@] Import...

’E Analysis Systems
[® Coupled Field Static
[ Coupled Field Transient
#3 Eigenvalue Buckling
) Electric
{9 Explicit Dynamics
& Fluid Flow - Blow Molding (Polyflo
& Fluid Flow - Extrusion (Polyflow)
{3 Fluid Flow (CFX)
& Fluid Flow (Fluent)
& Fluid Flow (Polyflow)
| Harmonic Acoustics
@9 Harmonic Response
B9 Hydrodynamic Diffraction
4 Hydrodynamic Response

Project Schematic

v A

2 & Engineering Data
3 O Geometry

4 @ Model

5 @ Setwp

6 ﬂ;ﬁ Solution

7 O Results

Static Structural

BE VII SEMESTER FINITE ELEMENT ANALYSIS LAB MANUAL

<y Reconnect %) Refresh Project # Update Project | g ACT Start Page

b8l 77 Static Structural

A

| N NN

ogf) | ogf) | ogfl | o) | sgd |
L
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Dimensional Cantilever Beam Geometry

Creating Rectangular Beam Profile

&
Bron
9 -

- B: 10mm = ANSanSz

H: 10mm

roperties

Reducing Rectangular Profile

s

. H: Tmm
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Connect Line to beam

Home
a > E
Wreoview! ~F ' = Gy Sewns 00 P @recs  Msmpesges| — S 07T ope -
OO |Lohme Mawen Excows o @ | inederee @ snontdges| B cioance | Tooe? B ot HiSpt | vrcant
Orient Analysis Remave Detect Boams AcT

Pick two paynis to create a beam between them Pick an edge or curve to create a beam on ANSYS

2020 R2
ADEMIC

ayers Selecton Groups Views

-
ze 0a

Step 2 :- Givini Material Properties -Right Click Materials -Right- Click - Model.
Toolbox

Project Schematic

|E Analysis Systems | ~
[ Coupled Field Static
(& Coupled Field Transient Y A
Y Eigenvalue Buckling 1
(&) Electric 2 g Engineering Data *
I Explicit Dynamics i
& Fluid Flow - Blow Molding (Polyflo 3 B Geometry v 4
& Fluid Flow - Extrusion (Polyflow) 4@ Model v 4]
& Fluid Flow (CFX) 5 @ setn ?,
& Fluid Flow (Fluent) — -
@ Fluid Flow (Polyflow) 6| @ Solution 7 4
) Harmonic Acoustics 7 @ Results A,
@ Harmonic Response Ty ——
Hydrodynamic Diffraction
(__NCREE S SN R St £

Step 3 :- Creating Mesh - Click Mesh - 1 Dimensional Meshing is done.

Step 2 2D meshing
Click on static structural
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File View Tools Units Extensions Jobs Help
re s
JL? Ig‘ﬂ [ H Project

@] Import... | <9 Reconnect |¢] Refresh Project # Update Project | @ ACT Start Page

Project Schematic

E Analysis Systems | ~
[® Coupled Field Static
[ Coupled Field Transient 54 A
(&) Electric 2 | @ Engineering Data v g
% Explicit Dynamics t >
Fluid Flow - Blow Molding (Polyflo 5 9 Seometry L
& Fluid Flow - Extrusion (Polyflow) 4 @ Model R 4
{5 Fluid Flow (CFX) 5 @ setwp T 4
& Fluid Flow (Fluent) '@ sout =
@ Fluid Flow (Polyflow) £ W Soution = a
) Harmonic Acoustics 7 @ Results ?,
(¥ Harmonic Response St el
Hydrodynamic Diffraction
9 Hydrodynamic Response
\
|
\
\
1
| :
5mm
50mm
\
|
i
|
St 20 1ttt St i e 0 o ANSYS
L o

Right Click Update Geometry

3D Mesh

BE VII SEMESTER FINITE ELEMENT ANALYSIS LAB MANUAL Page 16



Methodist College of Engineering & Technology
Department of Mechanical Engineering

File View Tools Units Extensions Jobs Help
g5 e A
(1| & |[& | / [HPproject

@lImport... | <% Reconnect [¢] Refresh Project # Update Project | B ACT Start Page
Project Schematic

E Analysis Systems | ~

I_@ Coupled Field Static

[ Coupled Field Transient B¢ A

@ Electric 2 @ Engineering Data v g
Y Explicit Dynamics : —
& Fluid Flow - Blow Molding (Polyflo 2 0 Seomety = a
& Fluid Flow - Extrusion (Polyflow) 4 @ Model ® 4
&3 Fluid Flow (CFX) 5 @ setup ?,
Fluid Flow (Fluent) P =
& Fluid Flow (Polyflow) o , ouRn 5 4
Ll Harmonic Acoustics 7 | @ Results B
(&9 Harmonic Response s
Hydrodynamic Diffraction

&% Hydrodynamic Response

Create Geometry
10mm

3D Geometry
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@‘U
B
&
S
®

2@
@
(9
[ 00mm] ]
%
3D Mesh

BE VII SEMESTER FINITE ELEMENT ANALYSIS LAB MANUAL Page 18



Methodist College of Engineering & Technology
Department of Mechanical Engineering

RESULT & CONCLUSIONS:
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VIVA QUESTIONS:

Differentiate between , 1D, 2D, 3D Meshing ?

Define Nodes ?

Define Convergence ?

What are the various quality Creations for meshing ?

Is it possible to solve a problem without meshing ?

Enumerate geometry Clean up ?

Define Auto mesh ?

Geometry clean-up, Mid-Surface ?

When to use 3-D Elements, DOFs for Solid Elements, Quality Checks for 3-D
Elements ?

VvV VvV WV V¥V V VY V VYV VY

> How to do Meshing Without Surface
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EXPERIMENT - 03
ANALYSIS OF 2D TRUSSES

AlM:
Analysis of Plane Truss to determine member forces, stresses, deflections under static
loading.

SOFTWARE: ANSYS

THEORY:

Consider the four-bar truss shown in figure. For the given data, find Stress in each
element, Reaction forces, Nodal displacement. E = 210 GPa, A = 0.1 m?.

2500 N

>

3m

1
?’] 4m y S '

vad | 3 X )

PROCEDURE:

Step 1: Workbench Toolbox
Toolbox - Analysis Systems - Static Structural
Open Static Structural dialog box will appear

File View Tools Units Extensions Help
[INew [Fopen... [l save [Elsaveas... | gglimport... | <pReconnect @ Refresh Project

|

~ 1 x ESEEEENE
I B Analysis Systems I
Design Assessment

Electric > A

Explicit Dynamic b8l == Static Structural

Fluid Flow - Blow Molding (Polyflov) 2 | @ EngneeringData +
i - i I v

Flu!d Flow- Extrusion{Peolyflow) 3 Q Geometry -

Fluid Flow (CFX) =

Fluid Flow (Fluent) 4 @ Model € 4

Fluid Flow (Polyflows) 5 | @ setup Pa

HarmonicResponse 6 & Solution .45

Hydrod ic Diffractit =
ydrodynamicDi on 7 | @ Results > .

Hydrodynamic Time Response
IC Engine

Linear Buckling
Magnetostatic

Modal

Modal (Samcef)

Random Vibration

Static Structural

Response Spectrum
Rigid Dynamics

Static Structural

Static Structural (Samcef)
Steady-State Thermal

In that Engineeriﬁg Data open by default Structural Steel will be there

CODOEECEEEIRERADDANEER

Close Engineering Data and from dialog box open Geometry
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Step 2: Create A Geometry

From dialog box open Geometry

File View Tools Units Extensions Help

P JNew [ZZOpen... =l save [Elsaveas...

|EAnalysis Systems

Design Assessment

3} Electric

Explicit Dynamic

(C4 Fluid Flow - Blow Molding {(Polyflow)
Fluid Flow- Extrusion{Polyflow)
Fluid Flow (CFPX)

Fluid Flow (Fluent)

Fluid Flow (Polyflow)
Harmonic Response
Hydrodynamic Diffracion
Hydrodynamic Time Response
IC Engine

Linear Buckling

@3] Magnetostatic

Modal

Modal {Samcef)

Random Vibration

Response Spectrum

Rigid Dynamics

Static Structural

Static Structural {(Samcef)
Steadv-State Thermal

Select XY Plane and make it Look at Face
Set Units as Meter

] File Create Concept Tools View Help

A

Static Structural

~
=
o
2
=2
2

[ SRS S L

| AHB| @] Dunde Gredo [[select[*y - | R BRB | w0~ | M 8[| S ¢ QAR QA% |+ Ge [

I AW APAT APAP AT ik

| xtPiane v | None

-8

| </ Generate @ Share Topolony  [EE|Parameters

| BEdrude @Revolve Qo Sweep  § Skin/Loft

| WThin/Surface @ Blend v & Charfer @pSlice || @Point B) Conversion

Tree Outline

R Graphics

B[] A: Static Structural
Ley3he XYPlane
<y ZXPlane
vy YZPlane

-8 0Parts, 0 Bodies

s SR——

Sketching  Modeling
Details View L
=I| Details of XYPlane i

Plane XYPlane

Sketches 0 ®

Export Coordinate System? | No o

0,000 15,600 30,000 ()
7.500 22,500
Model View | Print Preview

[ @ Ready 1Plane Meter b o 4

Sketching - Draw — Line
Draw the line on X axis by using Line tool bar complete the diagram
Sketching - Dimensions - Horizontal 4m

Vertical 3m
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| File Create Concept Tools View Help

|2HE (@] undo Greie [[seec[y I [mE MM &~ | HH |G+ QARAQEQ A 1@ [ | W W fr fie fr S S AP
| Xtprane v k| sketent -8
|

|

|

;

 Generate 9 Share Topolony  [BE]Parameters
Bedude ghRevolve GpSweep  § Skin/Loft
WThin/Surface @ Blend v 4§ Chamfer @ Slice U @Point ) Conversion

Toolboxes 2 L
Draw.
Modify
Dimensions -
& General
1o Horizontal
[ 3 Vertical
&~ Length/Distance
(< Radius
€ Diameter
A Angle
Z% Semi-Automatic
& kdit
e
Constraints v
Settings
Sketching | Modeling
Bl Sketcht A ¥
Sketch Sketchl :
Sketch Visibility | Show Sketch ®
Show Constraints? | No
— S
| H1 4m SR 0.000 4.000 8.000 (m)
[ s |
B L E‘ii. 200 500
Line ‘lrﬂ - ~ ;
tne s v | Mogelview [ Pint e
ertical -- Select first point or e for Vertical dimension lo Selection eter
Vertical -- Select first point or 2D Edge f ical dimensi No Selecti M 0 0 4

Go to Concept - Cross Section - Circular — R0.0364

| File Create | Concept Tools View Help

| =1 kel &l | "~ Lines From Paints clect: [ "y Te- || tm| 07 T5 W |
| xvPlane 7 Lines From Sketches
T =7 Genarmte| T it Do G -
TR et oo | urve

I = Lot

~= Split Edges
¥ Surfaces From Edges o Siice || @ Point  Eo Corersion
=8 Surfaces From Sketches i
& Surfaces From Faces

|

Dimensions
& Genaral
1t Horizontal
[IC Vertcal
2 Langth/Distance
Radius. L Section
_pDiameter T Section
25 Angle Hat Section
#F Semi-Automatic Rectangular Tube
i Edic User Integrated
Constraints 8 User Defined
Settings T
[ I
Details View »
1= Detais of SKetcn1 ~
Sketeh [Sketeni

Sketeh Visibility Show Sketeh

Show Constraints? |No
(=1 Dimensions: 2
I H1 am

am
(=1 Edges: 4

Line |in7
Line sl ~ | _moder view [Print Previe

[ @ Wertical -- Select first point or 20 Edge for Vertical dimension

ree wuune

[E)-/88] A Static Structural
7 XYPlane
Lok DiPlane
Sy VZPlane
E}-y @8 1 Cross Section
P, @ Circularl
LB 0 Parts, 0Bodies

Sketching Modeling

Details View
=1/ Details of Circulart =
Sketch | circutart
Show Canstraints? | No
=] Dimensions: 1
[
gt 0.000
Full Circle [en3 ]
=] Physical Properties: 10
A 000031416 m?
o 17.7390e.009 m"4 v |_Model View | Print Preview
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Go to Concept — Lines From Sketches

(il
File Create | Concept Tools View Help
Al = |

XVPlane

7 Generate | [T Linss From Edges -

% 3D Curve
= Split Edges et
WA Thin/Surf| g Surfaces From Edges b || #p
Tree Outline | 8l Surfaces From Sketches LG
[El-l8 A: St| &2 Surfaces From Faces
3| Cross Section v

R Extrude

::,;. ¥ZPlane
Sh-vg8 1 Cross Section
§ L@ Circularl

L. 0 Parts, 0 Bodies

Sketching Modeling

Details View E
=1 Details of Circular1 ~
Sketch |crreutan
Show Constraints? | No

= Dimensions: 1

IR |00384m
Edges: 1

Full Circle [enz

1| Physical ies: 10

A |0.0041625 m®
o [1.3588e.006 m~a =

[ '@ Reagy

o]

A: Static Structural — XY Plane — Sketchl — Apply

File Create Concept Tools View Help

JARE @[ Dunde @redo [[select *; B[R C- | HE[|S - QARAQEAQ @ X [[[6fe [ || M~ W g fiv S A S A 7

XYPlane v | sketent v

</ Generate @ Share Topology  [E5]Parameters

WEdrude gRRevolve Qg Sweep @ Skinfloft

W Thin/Surface QBlend v & Charnfer @Siice || @ Foint B) Comversion

-8 A: Static Structural

Ly @ Circular!
/& 0Parts, 0 Bodies

Sketching Modeling

Detals View 2
=1| Details of Line1 i
@
X
0.000 1500 3.000(m)
]
0750 2.25
Model View | Print Preview
| 7 Lines From Sketches Creation -- Select base objects for this feature 1 Sketch Meter o 4
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Linel — Generate — 1 Part 1 Body — Line Body — Cross Section — Circular 1

File Create Concept Tools View Help

AHB |G| D Grbo sty b RRRR @ [0 2| S QARQABAR AR+ @ [0 I R AP AP AT AT
XiPlane v | sketent - =

~/ Generate @@ Share Topology [£F]Parameters

| @Edrude giRevolve @ Sweep  § Skin/Loft

| WThin/Surface QuBlend v & Charnfer @ Slice I] @ Point B Conversion

Tree Outline 2 Graphics 7
- &@] A: Static Structural
El-y3h XYPlane
Ly Sketchl
<y ZXPlane
-y YZPlane
% Linel
-y 1 Cross Section
Ly @ Circular]
-, 1Part, 1 Body
Ly~ Line Body
<
Sketching  Modeling = —_
Details View 2
= Details of Line Body ¥
Line Body
@
X
0.000 1500 3.000(m)
None ]
0750 225
Model View | Print Preview
| @ Ready [1Body Meter oo 4

Step 3: Model
From dialog box Select

Model Model — Update

File View Tools Units Extensions Help
INew [5Open... Il save (&l save As... |ﬁ]lnpor

‘oolbox Rl Proje

[ “oRecomect ;& Refresh Project / Update Project | 4

B Analysis Systems |
Design Assessment v
Electric 2d A
Explicit Dynamics i
(@ Fluid Flow-BlowMolding (Polyfiow) 12| @ EngneeringData v
g Flu!dFIaw-Ettmsmn(Polyﬂaw) 3 ® Geomelry L
Fluid Flow (CFX) ot =
@ FluidFlow (Fluent) 4[® vooe G s
Fluid Flow (Polyflow) 5 | @ setp
HarmonicResponse 6 | §3 Soluton E3 Duplicate
Hydrodynamic Diffraion 7 @ Resuts Transfer Data FromNew b
& i
Ix'icy::;?"):lammﬁme Hespoms Static Structul Transfer Data To New »
Linear Buckling 7 Update
Magnetostatic Clear Generated Data
i Modal 2 Refiesh
[ Modal (Samcef)
fily Random Vibration Reset
filjy Response Spectum @ Rename
kA Rigid Dynamis Properties
Static Structural i
[ Static Structural (Samcef) Quick Help
Steady-State Thermal Add Note
Thermal-Electric
—EVA
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Open Model
Geometry — Line Body — Assignment — Structural Steel

File Edit View Units Tools Help =i | /Solve v 2/ Show Errors b & v Worksheet 1
7 1N

AR R-"ERERI@ISTrAQAQE@AAE N E O

| B Show Vertices gRWireframe | Wl Edge Coloring v £~ /v A~ A~ fiv A || |~1Thicken Annotations TShowMesh & [ Random Colors Z5 Annotation Preferences

| Geometry @ virtusl Body | @4 PointMass % Thermal Point Mass  wThickness wgimported Thickness @B Layered Section | &b |
Outline L3

|Filter: Name alm

5.000 (m)
'3 ]
~
B No
Coordinate System Default Coordinate System x
By
Offset Mode Refresh on Update
Offset Type Centroid
Model Type Beam
=/ Material
i Structural Steel
Nonlinear Effects Yes
Thermal Strain Effects | Yes
[+ Box
Properties v
|P155 F1 for Help ]t;@ No Messages |No Selection |Me’lric (m, kg, N,s,V, A) Degrees rad/s Celsius A

Mesh — Generate Mesh

M
File Edit View Units Tools Help |J @ =i | fsolve v ?2/ShowErors T WE
RAYER-CRREE/ @IS AR’ Q@A
5 Show Vertices R Wireframe | Wl Edge Coloring ~ £~ A~ A~ A~ A~ A
Mesh -/ Update | @ Mesh v @ Mesh Control v | [ietric Graph

& @] v (B Worksheet in
QEnges |0
[

[~ Thicken Annotations "% Show 1viesh sk Bl Random Colors > Annotation Preferences

|Filter: Name  + HE
&) Project
= ([§] Model (A4)
E-/& Geometry
| g Line Body
2 Coordinate Systems
é"‘_/EIS}f Insert
Ay
& ?G -/ Update

Preview
=} Create Pinch Controls

/] Clear Generated Data

b Rename

ekl of Mesht | StrtRecording W 00000
= Defaults

Physics Preference [

| Relevance lo
sizing
| Inflation
= Patch Conforming Options

Triangle Surface Mesher |Program Controlled
'+ | Advanced
| Defeaturing
=
|Press F1 for Help [ |0/ No Messages |No Selection |Metric (m, kg, N, 5,V, A) Degrees rad/s Celsius 7

Select Vertex — First Point — Static Structural — Insert — Fixed Support
Second Point — Static Structural — Insert — Fixed Support
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M
| File Edit View Units Tools Help || @ = | 3/Solve v 2/ShowErrors tH W ] [ v @ worksheet ix

2 Y R-EERRR(&-ISAQAQAEAAR g8 |0

| & Show Vertices @@ Wireframe | Wl Edge Coloring v £~ /v A~ A~ A~ A |b| |-IThicken Annotations T Show Mesh & Il Random Colors (@ Annotation Preferences
| Environment @ Inertial v @ Loads v @ Supports v Sk Conditions v @, Direct FE ~ | B |

|Filter: Name  + alm

[§ @ Acceleration

o @} Standard Earth Gravity
( 7 @, Rotational Velocity g
/] Clear Generated Data @ F 3
alb Rename D
|, Remoteforce )
3 Open Solver Files Directory &, Moment
& Joint Load
- g,, xed Suppo 000 2500 5.000(m) & *
Details of (A3) s 4 1.250 3.750
=/ Definition @, Remote Displacement
Physics Type Structural Geome EL Simply Supported ]
Analysis Type Static Structural 1Graph | @ Fixed Rotation
Solver Target ical APDL 9, Elastic Support
= Options g 1.
] 2.°C ), Constraint Equation
Generate Input Only [No. & Vot
2 Motion Loads...
B Commands

. Messages Graph |
|Press F1 for Help 1,0 No Messages 1 Vertex Selected: Location = (0., 3, 0) m |Metric (m, kg, N, 5, V, A) Degrees rad/s Celsius 4

Third Point — Static Structural — Insert — Fixed Rotation

M

| File Edit View Units Tools Help || @ =¥ | /Solve v 2/ShowErrors T i & W orhest iy

(R R-RRRR&SAQQaFARAARNYE (O

| 5 Show Vertices @ Wireframe | Wl Edge Coloring v £~ A~ A~ A~ A~ A || I|-IThicken Annotations O Show Mesh & Il Random Colors (@ Annotation Preferences
| Environment @ Inertial v @ Loads v @ Supports v S Conditions v @, DirectFE v | B |

[ @ Acceleration

T @] Standard Earth (:jravlty
3, Rotational Velocity
(A6) 9 Clear Generated Data
i @, Force i
&b Rename
&, Remote Force
4 Open Solver Files Directory @, Moment ®
% Joint Load X
— 0000 1.500 3.000(m)
Details of (As) 2 )
=l 0.750 2.250
= Definition l‘ -
Physics Type Structural I ]
Analysis Type Static Structural = =
Solver Target APDL Elasic Support =
P!
|| Environment Temperature | 22, °C @, Constraint Equation
Generate Input Only [No

¢ Motion Loads...

B Commands

. Messages Graph |
[ 138/ No Messages [1 Vertex Selected: Location = (4, 0, 0) m |Metric (m, kg, N, 5, V, A) Degrees rad/s Celsius 4

Press F1 for Help

Fourth Point — Static Structural — Insert — Force
Components —Y Component — (-
2500 N) -ve sign is for down ward direction
Third Point — Static Structural — Insert — Force
Components — X Component — (

2000 N)
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M

File Edit View Units Tools Help || @ =i | */Sove v ?/ShowErors @ ¢ [8 # [ v @ worksheet ix

RATYTE-ERRR (& SAQAQAFAAR a8 O

5 Show Vertices  #@Wireframe | Wl Edge Coloring v £~ A~ A~ A~ A~ A [p| |-IThicken Annotations TShowMesh & [ Random Colors (@ Annotation Preferences

Environment & Inertial v @ Loads v & Supports v @, Conditions v @, Direct FE v | B |
Outline ]

| Filter: Name v

[ &1 Acceleration

o andard Earth Gravity
L4 @), Rotational Velocity
] Clear Generated Data
db Rename
3, Remote Force
4 Open Solver Files Directory &, Moment .
4 Joint Load
&, Fied Support uog: 1.5&0 3.000(m)
i &, i . 0.750 2.250 .,
Physics Type Structural % Bemote D
e
Analysis Type Static Structural ] .? Sunply S""f"”“‘
Solver Target ical APDL %, Fixed Rotation
o ), Elastic Support 1.
L [22.°¢ @, Constraint Equation
Generate Input Only [No.
&F Motion Loads...
B> Commands
. Messages Graph |
|Press F1 for Help [ 1,0 No Messages 1 Vertex Selected: Location = (4, 3, 0) m |Metric (m, kg, N, 5, V, A) Degrees rad/s Celsius

™M
| File Edit View Units Tools Help || @ i | /Solve ~ 2/ShowErmors t & @~ @ worksheet i
RAYE-CERRR /& STARAIQE@AAR M8 DO

5 Show Vertices R Wireframe | Wl Edge Coloring v £~ A~ A~ A~ A~ A [Pl |-IThicken Annotations T3 Show Mesh & B Random Colors @ Annotation Preferences
Environment @ Inertial v & Loads v @k Supports v @ Conditions v &, DirectFE v | B |

|Fitter: Name + A\
(] Project
- (@ Model (A4)

o E

: 000 1500 3.000(m)
stic Structural (A5)" - ]
> (6] 2 BB 0.750 2.250

Physics Type [Structural APrint Preview Report Preview/ ]
Analysis Type | static structural
Solver Target | ical APDL -
|| Envi [22.c
Generate Input Only [No
. Messages Graph |
Press F1 for Help 150 No Messages No Selection [Metric (m, kg, N, s, V, A) Degrees rad/s Celsius 4
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Solution — Insert — Deformation — Total — Solve

M
File Edit View Units Tools Help || @ =i | /Solve v 2/ShowErors tH i L] (@) @ Worksheet ix

RATYTE-ERRR /(& ISTARAQAQBARAAR 8 |0

5 Show Vertices  #@Wireframe | Wl Edge Coloring v £~ A~ A~ A~ A~ A || |~IThicken Annotations TjShow Mesh & B Random Colors (7 Annotation Preferences

Solution B Deformation v L Strain v B Stress v L Energy v | % Damage v | @ Probe + ools v | @, User Defined Result | £= Carnphell Disgrarn | @ Coordinate Systems v &, Beam Results v B

B als

=} Solve Contact Tool
£ Clear Generated Data Probe > e [ 2.800(m)
_— 0.750 2250 Al
| e Coordinate Systems »
Max Refinement Loops | . | "y Open Solver Files Directory -
Refinement Depth | 2. " - Beam Results b
e f Beamn Tool » "
Status | Solve Required | —_— .
€, User Defined Result
[ Commands
I
0. 1.
. Messages Graph |
|Press F1 for Help [ [0/ No Messages |No Selection [Metric (m, kg, N, 5, V, A) Degrees rad/s Celsius 4

Solution — Insert — Coordinate Systems — Elemental Triads — Solve

M
File Edit View Units Tools Help |] @ =i | Jsove v 2/ShowErors H h 7] @] v (@ Worksheet iy
RAYER-CRRBRE @ ISrRAAIQA@RARNF 8 (O
5 Show Vertices g Wireframe | Wl Edge Coloring v £~ /v A~ A~ A~ A || |-IThicken Annotations TjShow Mesh 4 B Random Colors 5 Annotation Preferences
| Solution @ Deformation v B Strain v @ Stress v . Energy v | & Damage v | @ Probe v ([@|Tools v | &, User Defined Result | =] Carnpbell Dizgrarn | @ Coordinate Systems v @, Beam Results v [

|Filter:  Name 2] @E :

Deformation ®
— e L X

/] Clear Generated Data Contact Tool »
DT — 0,000 2,000 4.000
T ik R [, . o 200m)
AN
Max Loops |1. o | XV Angl
i Depth |2, Beam Results 0P Noda) Eulee XY Ancle
= Mes 3, Nodal Euler YZ Angle
| »
Status [Done _ BeamTool ¥/, Nodal Euler XZ Angle
8, User Defined Result
BC = @, Elemental Euler XY Angle
n
S , Elemental Euler YZ Angle
5, Elemental Euler XZ Angle
<
. Messages | Graph |
Press F1 for Help [ | A& 1 Message No Selection |Metric (m, kg, N, 5, V, A) Degrees rad/s Celsius 7
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Solution — Insert — Coordinate Systems — Nodal Triads — Solve

M
| File Edit View Units Tools Help || @ i | fSolve ~ 2/ShowErmors T [ L @] v (F7Worksheet  ix

AR ERRARS-SrRAAIQAFARAAE N8 (O
| B Show Vertices  #@Wireframe | Wl Edge Coloting v £~ A~ A~ A~ A~ A |P| |<IThicken Annotations D Show Mesh & [ Random Colors ) Annotation Preferences
| Solution @ Deformation v @ Strain v @ Stress v @ Energy v | % Damage v | @ Probe ools v | @, User Defined Result | £ Cornpbell Dizgrar | @, Coordinate Systems v @ Beam Results v [

| Filter: Name v

tatic Structural (A5)
/X Analysis Settings
/B, Fixed Support

Deformation | @
X

/] Clear Generated Data Contact Tool »
0000 2.000 4,000
b Rename e R 00 000 000
oty T . = =
MaxReft Loops 1. 9, Nodal Euler XY Angle |
3 T BeamResults » o 9
EokDesth, 2 | ®, Nodal Euler YZ Angle 2
Status Toone Beam Tool » B, Nodal Euler XZ Angle :’Ass—
Project>Model>
User Defined Resut emental Tria 0 =
3 @, Elemental Triads .
— | ®, Hlemental Euler XY Angle
[¢ d: 9
B Cormands 9, Elemental Euler YZ Angle
B, Elemental Euler XZ Angle
. Messages | Graph |
Press F1 for Help [ | & 1 Message No Selection |Metric (m, kg, N, s, V, A) Degrees rad/s Celsius 4
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RESULT& CONCLUSIONS:
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VIVA QUESTIONS:

» What do you mean truss?
» Define Meshing ?

» Differentiate Beam Vs Bar?
» Whatis F.E.A?

» Explain the process of F.E.A
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EXPERIMENT - 04
STATIC ANALYSIS OF PLATES WITH A HOLE

AlM:

Static Analysis of plates with a hole to determine the deformation and Equivalent Stress.

SOFTWARE: ANSYS

THEORY:

The objective of this experiment is to demonstrate the basic ANSYS Space Claim
procedure to draw and perform simple analysis This problem is a simple dimensional
structural problem of a simple bracket as shown in figure .The bracket is made of 10 mm
thick steel plate . The material properties of steel are given below:

¢ Young’s Modulus, E =200 10° Pascal
e Poisson’s Ratio,y =0.3
e Density, p = 7860 kg/m3

REVSIGN HISTORT
] BOEEY AR SHEHD

NOTES: @onm

P —

— ilnn

e o |

INIT | apPROVALS |DWTE fIMIT | APPROVALS |paTe Exp-i
e »

e
BT o dee =T
KT AT [T ek B [ |
APPLICATION = | | S

The forces Acting are shown below

PLATE THICKNESS: 20 mm
ALL DIM IN mm

\5\‘,0_
h¢

L

; 80
R
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PROCEDURE:

Stepl: Workbench Tool box
Toolbox-Analysis Systems-Static Structural
Click on Static Structural Analysis

Click on Geometry Space Claim

Response Dialogue Box Will Appear :-

.,”, Unsaved Project - Workbench
Fle View Tools Units Extensons Jobs Help

~ @

i == 3 | Project
jlimport... | ¥9Reconnect [2] RefreshProject 7 Update Project | &5 ACT StartPage

‘E! Analysis Systems ‘ ~

@ Coupled Field Static

& Coupled Field Transient Y A

) Eigenvalue Buckling 1
(&) Electric

B Expic Dynamics 2 |@ Engineering Data ¥ 4
& Fluid Flow - Blow Molding (Polyflo <
& Fluid Flow - Extrusion (Polyflow) 4@ Model ? .
& Fluid Flow (CFX) 5 @@ sewn ?
& Fluid Flow (Fluent) —
& Fluid Flow (Polyflow) 6 @ soution ?.
&) Harmonic Acoustics 7 @ Results 2 .
[ Harmonic Response pre

B4 Hydrodynamic Diffraction

) Hydrodynamic Response

&4 1C Engine (Fluent)

(&) Magnetostatic

Step2-Creating Geometry
Click on geometry Dialogue box Space Claim option will open.

ANSYS

2020 R2

4
7o
/
‘
:r‘,
2 :
0% 4B

A Do

Select any Plane Using Pan View
Set Units as mm
Sketch Two Line perpendicular to each with 200mm dimension each as shown in figure.
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File Design  Display  Assembly  Measure e Repair  Prepare Detail
] Home ~ g OO Y XN w4 A i /
g\ ® O 92230358 1 2247 I
&4 Plan View » © VER | - X % ¥ I
S -y = . Select E t
8- e Cice Ra .UD | B @ It N - Move
Clipboard Orient Create Modify Constraints Edit End Sketch
1
Sl Edit the text
4||& Designt*
b [V [@ Sketching Planel
‘Struclurel Layers Selection Groups Views
100mm
Options
100
Properties 1
|~ Arrows A
|v Arrow1Style [ Default |
Length Default
Width Default -
~ Arrow2 Style  [] Default (Y) =X
Length Default | ;
Width Default z ‘ *‘
v General @ =)

Draw a circle of 60 mm radius at a distance of 50mm from vertical as shown in figure.

Click a reference to start creating dimension. Ctri+Click two objects to create a virtual point or line

100mm

(Y ) +X

N -=(

P LN
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Draw another circle with 200 mm diameter as shown in figure.

100mm

b {00mme

Draw another circle with

.................... | |

given dimensions

100mm
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(oo )
(]
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Giving Fillets
Modify 1 round

&

el |

Deleting Unwanted Geometry and line by selecting Delete icon

Select and drag a face to offset it. Select and drag an edge to round it.

&
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Click on Model Update it and wait for geometry to upload then double click it

m Unsaved Project - Workbench

File View Tools Units Extensions Jobs Help
R e
}@\@‘EE ’[] Project \

: @tmport... | €9 Reconnect [#] Refresh Project  Update Project | B ACT StartPage

Toolbox a X
IEAnalysis Systems I A
[ Coupled Field Static
Coupled Field Transient | A
Eigenvalue Buckling 1 Static Structural
Electric 2 @ EngneerngData
Explicit Dynamics i
Fluid Flow - Blow Molding (Polyflo 2 Seometry v 4
Fluid Flow - Extrusion (Polyflow) 4 Model &
Fluid Flow (CFX) 5 @ Setup E)
Fluid Flow (Fluent) @ sous — 4
Fluid Flow (Polyflow) g oy €4
)l Harmonic Acoustics 7 |@ Resits ?
Harmonic Response presm———
Hydrodynamic Diffraction
Hudradunamic Racnanca
me T e
[ R T — .
Ao X or - EH Stamesseletion [ commans: @images™ =, ° & Views & eview M £
do poeme g Wt e (W B M (e Sme e ([RAe
** B pute tamees | Cores)2 Sohe | Anaii @ o tetomt  Gfcret  EAmmotstion | USRS Wortihedt Kofme oy oy SluntComuter ey Augrments | 5720, CImet Layout
ousee Sone . et Yook ot
. ~%ox QA QR Sea Riode- THDNWBE B ¢ P ECipbond~ [Empry] Datend- 9 Seect By~ B Comven=
re— =
M Project
S 1 Model ()
&/ Goomery
® /Q Materals

Details of “Model (A4)" v8oOx
= Uighting

Ambient 0.1

ituse |06

Specutsr | 1

Color

Control | Enabled

- & x
~24@

ANSYS

2020 R2
ACADEMIC

Click on Mesh

[ Ji=hd Context A: Static Structural - Mechanical [ANSYS Academic Teaching Introductory)
Home = Mesh  Display  Selecion  Automation
D Lcut X Delete | My Computer - EE ®nsmed selection  [F Commands @images~ B H D Tags (&) Manage Views &
B copy QFind V' Distributed Bl . coordinate system TComment  Tlisection Plane = — @ wizard (i selection Information ;&R
DUPlcate oy pacte BaTree~ | Cores|2 Sove | Analysis g pemote Point i Chart Bannotation | Units Worksheet Keyframe o chow Errors i Unit Converter B
Outline Solve 7 Insert Tools

Outline ~RaOx

Name v |Sea tline |V o

Details of "Mesh" v+ 30Ox
I=! Display

Display Style [Use Geometry Setting

= Defaults

Physics Preference | Mechanical

Element Order I onglqm Controlled

Element Size  Default

QA 8w|@ % -4+ QA Q& St kMode- [TRE D@ B W ® ' P FClipbosrd- [Empt

+
) 0000 0.050 0100
I I ]
0.025 0075
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Boundary Condition :- Fix two small Holes
E v Context A: Static Structural - Mechanical [ANSYS Academic Teaching Introductory]
_ Home Environment Display Selection Automation
&Cut X Delete | My Computer - BB Susmedseiection  [F Commands @images~
O ¥

= H R Tags FManage '

O\Murd @Selenion

B copy QFind V' Distributed * Coordinate System CJComment (B Section Plane
i i . i Worksh:
Duplicate o pcte Batree~ | Cores|2 Sole | Analysis g cemotepoint  ffChat  EAnnotation | UMits Worksheet Xevirame o chow Ermors BB Unit Con
Outline Solve 1] Insert Took

Outline v iOox
Name v |Search Outline |V o
= (@ Model (Ad)
-,/ Geometry
- Materials
3% Coordinate Systems
v Mesh
-9 Static Structural (A5)
/I Analysis Settings
@, Fixed Support
=28 Solution (A6)
{5 Solution Information

QQ 8w % O -4+ QA QA sdct kM- TRRRNRBBB® 2 Ha

CRCRC)

m

Details of "Fixed Support” *4oOox
=/ Scope
Scoping Method ]Geometry Selection
Geometry ‘ 2 Faces
i~/ Definition
Type | Fixed Support Graph ~TOx
Suppressed ‘ No 1

Click on Bigger Circle and Give Force of -1000 pa in —x Direction

ﬂ H hd Context A : Static Structural - Mechanical [ANSYS Academic Teaching Introductory]
Home Environment Display Selection  Automation
Scut X Delete = My Computer - BB ®nsmedseiection  E: Commands (@ images~ ﬂ = ﬂ D Tags D Manage V
—I—- B copy QFind v Distributed Bl *i Coordinate System CJComment [ Section Plane - © wizard [ix]selection
; L A
Duplkate B paste %o Tree~ | Cores 2 So'lve Ana'lysu @, Remote Point il Chart [ Annotation U':m Warksheet A'Ef,{',.?.’,"‘,‘" [8 show Errors & Unit Conv
Outline Solve [ Insert Took
Outline vAO0X  QQ @@ % O QA QA st kKMode- TREDRB B ® C® Ho
Name w|Search Outline |V o
B Project*

5 (B Model (A4)
-/ Geometry
& {8 Materials

i,/ Mesh
-9l Static Structural (A5)
- 4J] Analysis Settings

Details of "Pressure" *iOx

=/ Scope
Scoping Method [ Geometry Selection 0.000 0.050
Geometry [1 Face 0.025 0.075

I=/| Definition
Type Pressure Graph 31 Ox
Define By Vector 1
Applied By Surface Effect o i 1 il
Loaded Area Deformed | T e L 4

Magnitude | -1000. Pa (ramped) eed 0 TTEEL, Sy’ i

Direction Click to Define T e
Suppressed No #1000 1
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Insert Deformation and VVon Mess Stress

- Ji=

A Static Structural - Mechanical [ANSYS Academic Teaching Introductory)

€% C-+QAQQ St kMode- [ TRRDREBE = Hc

Context
Home Environment Display Selection Automation
|D Hcut X Delete | My Computer - El S®nsmed
B copy QFind v Distributed m
Duplicate o p,cte EaTree | Cores|2 o . i chart
Outline Solve ] Insert
Outline vROox
Name v |Search Outline |V
[ Project*
B (@ Model (A4)
@ Geometry
(8 Materials
[#-- 3K Coordinate Systems
/@ Mesh
B[] Static Structural (AS)
/] Analysis Settings
-+, Fixed Support
/@, Pressure

/@ Total Deformation
/@ Equivalent Stress

Details of "Pressure”

B

vaOx

on [ Commands @images~
stem [JComment [BSection Plane
5 Annotation

= H D Tags (DManage
= @ wizard [Eselectior
Woksheet Axrm':t'i%: 8 show Errors i Unit Cor

Took

Make a copy of the selected object(s) and automatically insert it into the current Outline location.

Total Deformation

e Equivalent Stress
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Scope
Scoping Method | Geometry Selection
Geometry |1 Face
1 Definition
Type ]Htssuve Graph vilOox
Define By Vector 4
Applied By | Surface Effect [ —
loadedArea  |Deformed | T e
Magnitude  |-1000. Pa (ramped) o .
Direction |ClicktoChange | T e L
Suppressed |No 21000, 1
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RESULT & CONCLUSIONS:
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VIVA QUESTIONS:

Define Stress Concentration Factor?

What is the difference between surface and solid.?

How to provide thickness of surface in ANSYS Workbench?
What type of meshing is used for Surface Modeling ?

>
>
>
>
» What type of meshing is used for Solid Modelling ?
» What are the boundary condition for plate with a hole analysis problem ?
» Differentiate between Tetrahedron ,Quadrilateral ?

» Differentiate between structured Grid Vs Unstructured Gird?

» What do you mean by mesh Quality ?

>

How to decide Type of meshing ?
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EXPERIMENT - 05

STRESS AND DEFORMATION OF AXI-SYMMETRIC MODEL
AIM:

To calculate Stress in case of axi-symmetric body.

SOFTWARE: ANSYS

THEORY:
A. Create a 2D axi-symmetric model
B. Create a 3D sold model (1/4 symmetric)
C. Create a 3D shell (1/4 symmetric) , assume E = 207
vl

REVISION HISTORY
ey DEECMETON woonr Y pare SHEDKED
NOTES:

PARTS LIST
APPROVALS | naTE

' CTON 2
@9@ T T o i
L
APPLICATION =
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PROCEDURE:
Opening Space Claim
Drawing Geometry

AStatic Structural - Design1 - SpaceClaim

Display  Assembly  Measure Repair  Prepare Detail  SheetMetal  Tools  KeyShot
(&} Home  ~ N Q —] OO Y X e 4 A i R 7 'k 3¢ /
B Pion View Ll s o~ Nl ~s<40 & ¥ @ v
9 - D g @ It N\ Select byl Move Fil

Clipboard Orient Create Modify Constraints Edit End Sketch

Structure
4/ /& Design1*
b v [@ Sketching Planel

Snapping to Grid

[swcmm]uym Selection Groups Views
Options - Sketch
*\, Line

Define line from center

4 Sketch

#180mm

Automatically Cre
Snap to grid
Snap to angle

Layout Sketch

14) Dimensions

Properties

(NI1+<

(@)
(=)
|% |
(g8 |

Trim

A:Static Str

Sketch Design Display Assembly Measure Facets Repair Prepare Workbench Detail Sheet Metal Tools]

@ Home 007" YIXN R W A
0 ﬁ%nv»ew\@D%@'\oh:&'@ﬁ I‘-'I...;.(/,/, *é/)‘t\\ﬁ
Peste o' @ - Line Cicle Rectange . "y D & > X Dimension @ [§ N\, Select byl Move
Clipboard  Orient Creats Modify Constraints Edit
Structure '

Snapping to Midpont
4718 Designt*
b v [@ Sketching Planel

.
I
1
)
i
|
i
i
i
i
i
|
[structure| Leyers Setection Groups Views i
|
|

Options - Trim Sketch Curves
5#° General

Inverse trim

Properties
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Draw rectangle

EOSEMM Design  Display  Assembly Measure  Facets  Repair  Prepare  Workbench

Detail Sheet N
D (&} Home  ~ O E YXN TR/ W k
v NO O qao~. avo =< %a &
Poss 2l @ < Line Cicle Rectange . "3 ) Jf > ¢  Dimensin @ |b 3\ Select py
Clipboard Orient Create Modify Constraints
Structure

Click a reference fo! start creating dimension | Clri+Click two objects to create a virtu
4 /& Designt*

b || [@ Sketching Planel 2

[structure| Layers Selection Groups Views

Options - Dimensions

Dimension Orientation

® Auto
Aligned
Horizontal
Vertical

1st Reference Orientation

® Auto
Horizontal
Vertical

Properties }

v Arrows ~

v Arrow 1Style [_] Default
Length Default
Width Default

v Arrow2Style [ ] Default
Length Default
Width Default

v General

Moseuramant — Linaar

Trim

Design Display Assembly Measure Repair Prepare Detail
e o) B G REE e” 7A@
ﬁplan\ﬁew L N O™ o | ) G0 | I - X L K

r ~ e Rects . SO < Select
@ -8 | lne Cice Rectnge . 7 D B > X ension @ [} N\ :

Clipboard Orient Create Modify Constraints

Structure 1
4alv| @ Design1*
b v [@ Sketching Planel

Snapping to Curve, Grid

lStructure| Layers Selection Groups Views

Options - Trim Sketch Curves 4

+#° General

Inverse trim

Properties o
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Pull-Revolve

Select 1 or more faces or edges to revolve

&

A&
=

N sys x

n Home  Mesh  Display  Selection  Automation
D %cut X Delete | My Computer B Snamedselection [ Commands @Iimages~

B copy QFind v Distributed [+ '] * Coordinate System CJComment [ Section Plane
Solve | Analysis

|_ : H D Tags EDMan
e/ = @ Wizard [ixseles
i
E‘m icate B paste Pf.Tree' Cores|2 #, Remote Point 47 Chart B Annotation Units Worksheet AKnan:t?t‘)en ashow Errors B Unit
Outline Solve 1] Insert Took

Outline +3Oox QaQ ‘E‘g % O~ Q @Q @ @ Select " Mode~ ;ﬂ'@.@.mma‘$i
Name w | Search Outline |V o
[ Project*

& (@ Model (a4)

a v-,m Static Structural (A5)
- /JHl] Analysis Settings
.79 Fixed Support
9@, Pressure
=] 7. Solution (A6)
~4/{%) Solution Information

/@ Total Deformation
Details of "Mesh" +iOox
=/ Display
Pi_sglgx Style | Use Geometry Setting
i=l| Defaults
Physics Preference | Mechanical
Element Order Program Controlled
Element Size | Default
# Sizing
# Quality
| Inflation
'+ Advanced
* isti 0.000 0.050
I -
0.025 0.0}
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Boundary Condition

[~ B4 Context A Static Structural - Mechanical [ANSYS Academic Teaching Introductory]
Home Environment Display Selection Automation

D “Cut X Delete = My Computer - ﬁ BB Suamedseiection  [E Commands (@ images~ (—R = g D Tags DM
|— B mft [:—

(B Copy QFind v Distributed i Coordinate System [JComment [.Section Plane OWiurd E]Sel
i i . its Workshee
DuPlK'" B paste E|_'.Tre=' Cores 2 SO'M Am_'ym @, Remote Point 1 Chart B Annotation Ur:rts hees ;eiy,,'.m';en BShow Errors fait Un
Outline Solve r. Insert Tools
Outire 40X Q@ @wE e C -+ Q@@ st KModer TRRDBEDE
Name v |Search Outline |V

g
[=-/[ Static Structural (A5)
/M| Analysis Settings
- /@, Pressure
=9 Solution (A6)
{5} Solution Information

/@ Total Deformation
Details of "Pressure” v lOox
= Scope
| Scoping Method | Geometry Selection
fGeanEtry ' 2 Faces ' 0,050
=/ Definition
[Type | Pressure Graph e
‘Qeﬁrru B/ | Corv!ponﬂltsr 1
Applied By Surface Effect T A —
Loaded Area Deformed | et
| Coordinate Sy;(em Global Coordinate System e L o
|| XComponent |1000.Pa (ramped) | T leee-emettTT
Ir 7Tfomponent 0. Pa (ramped) 0. 3
| | ZComponent |0.Pa (ramped)
Suppressed | No

e Total Deformation
e Equivalent Stress
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RESULT & CONCLUSIONS:
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VIVA QUESTIONS:

> Define Axi-symmetric Element?

> What are different types of loading in case of axi-symmetric loading ?
> Differentiate between 2D, 3D Analysis?

> Differentiate between Stress And Pressure ?

> Differentiate between symmetric and Axi-symmetric?
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AlM:

EXPERIMENT - 06
STATIC ANALYSIS OF CONNECTING ROD

To do Static analysis of connecting rod.

SOFTWARE:

THEORY:

ANSYS

To determine the deformation and Equivalent Stress in case of connecting Rod

REVISION HISTORY
REY DESCRPTION HNCDRS BY DaTE CHECKED
MNOTES:
[l Al
B SR IGmm
47 18Imm
465 39mm = —-‘ES.E?mm
ﬁt#mmt O f0ziam [ I
! 150mm !
= T ngul TERT o I UERLLATUME
m‘lnf‘: DR TIEY G W0 CEFCARTION
FPARTS LIST
T | apPROVALS |DATE |[MT | AFPROVALS |paTE
[CoRTRACT N MATERIAL Experiment Mo -6
FirsEH TE
THRD ANGLE PROJECTION TREATMENT
SLUFE |CAGE COOE WG MO HEY
—@ G HEKT ARSY USED O EBIMLAR TO B | |
APFLICATION I | e

PROCEDURE:
Opening Space Claim
Drawing Geometry
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A:Static Struc

Design Display Assembly Measure ~a Repair Prepare Detail Sheet Metal
(&} Home ~ u\ O El o0 e XN S 4 A0 k
ﬁPlan View ND™ o ) F ﬁﬁ I I -~ X % P é &
0 - [t Line Circle Rectangle '1_ -’.) Z ;, X Dimensiar @ H \1\ Select Pull Mo

Clipboard Orient Create Modify Constraints Edit

Structure q
alv @ Design1*
b (V| [@ Sketching Planel

Click a reference to start creating dimension. Ctri+Click two objects to create a virtual point

|Structure‘ Layers Selection Groups Views 150mm i

Options - Dimensions a

Dimension Orientation N

® Auto
Aligned

Horizontal
Vertical

1st Reference Orientation

e Auto
Horizontal f f
Vertical Saiaiaasassaisssass: 7 ; P

Properties

Ao | R e e e

v Style [] Default ‘

Length Default |

Width Default ‘

v General ‘
Measurement  Diameter

v Precision ‘

Decimal Places Default
|

Draw Circle

Click to select. Double-glick to select a tangenit chaii- Double-cliok ‘again 1§ select a closed loop: Drag to-edit your sketch:

ZQ-YQ- »

E I

o O O
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AsStatic Struc
Design  Display Measure Repair  Prepare Detail  SheetMetal
©m 4 A4
- i = :
il Plan View el L
9 - LN > X @ Ik N Select pur Mc
Clipboard Orient Create Modify Constraints Edit
Siciin Snapping to Midpoint !
4 /| Design1

b v [@ Sketching Planel

P35mm
B40mm
I
| structure| Loyers Selection Groups Views

Options - Trim Sketch Curves

3¢ General

Inverse trim

Properties

Pull

File Design  Display  Assembly  Measure

Facets  Repair

Prepare ‘Workbench Detail Sheet Metal

@‘Gﬂome-\GDOUWG'\‘.XQ @7 4 A i k

: 2oy e axit| [T -5 <4 n | i
et 7 9-8 Line Circle Rectange ™, 'y D P > X Dimensior TR Select | pyi | Mov
Clipboard Orient Create Modify C i Edit
i
S"uimpe Select and drag a face to offset it. Select and drag an edge to round it
4alv [§ Design1*

V@ soli
:\ 9 sm:: k
A&
™A
£q
‘Slruc{ure|Layers Selection Groups Views ‘%‘

Options - Pull ?
£ General

o Add == Cut @ Nomerge
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Draw 2D rod
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Boundary Condition
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RESULT & CONCLUSIONS:
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VIVA QUESTIONS:
> Differentiate Between Solid Meshing and Shell Meshing ?
> Explain the boundary condition in case of connecting rod ?
> What are different types of forces acting in connecting rod ?
> Define factor of safety ?
» How can FEA be used to optimize the design .
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EXPERIMENT - 07

STATIC ANALYSIS OF CURVED SHELL DUE TO INTERNAL
PRESSURE

AlM:

To find out deformation and equivalent stress of a curved shell due to internal
pressure.

SOFTWARE: ANSYS

THEORY:
From the following given diagram of pipe calculate the internal pressure in the pipe.
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Create Construction Line

Click a reference to start creating dimension. Ctri+Click two objects to create a virtual pgint or line
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Inserting Pressure in Y Direction of 1000 Pa
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RESULT & CONCLUSIONS:
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VIVA QUESTIONS:

» What are different types of stress in case of Pipe

What is the difference between Longitudinal stress and lateral stress ?
What type of meshing is used in the analysis of shell element

What do you mean by stiffness matrix

YV V. V V

Define shape function
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EXPERIMENT - 08

MODAL ANALYSIS OF BEAM TO CALCULATE NATURAL
FREQUENCY OF BEAM

AlM:

To determine Natural frequency and modal analysis of beam.
SOFTWARE: ANSYS

THEORY:
Determine the Natural Frequency in case of Beam as shown in figure.
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RESULT & CONCLUSIONS:
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VIVA QUESTIONS:
> Define Natural Frequencies ?

> What is the significance of modal analysis ?
> What is the Significance of Poisson’s Ratio ?
> Define Rigid Body ?

> How To Determine the Element size in case of analysis
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EXPERIMENT -09
STEADY STATE THERMAL ANALYSIS OF CHIMNEY

AIM:

Steady state heat transfer Analysis Cross section of chimney.

SOFTWARE: ANSYS

THEORY:
Determine The steady heat transfer analysis in case of chimney
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RESULT & CONCLUSIONS:
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VIVA QUESTIONS:

Differentiate between Steady state temperature vs Transient temperature >

Define heat Flux ?

>
>
» What is the significance of the coefficient of thermal expansion ?
» Define heat Conduction ?

>

Define Heat Convection ?
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EXPERIMENT -10
NON-LINEAR ANALYSIS OF CANTILEVER BEAM WITH NON-
LINEAR MATERIAL

AlM:

To determine deformation in case of cantilever beam with nonlinear material

SOFTWARE: ANSYS

THEORY:
From the given dimension below assign non linear material and find out the TOTAL
DEFORMATION.
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RESULT & CONCLUSIONS:
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VIVA QUESTIONS:

Differentiate between linear and non linear Material ?

Define Yield Point ?

>
>
» Define Ultimate tensile strength?
» Define Plasticity ?

>

Define Elasticity ?
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EXPERIMENT - 11

COUPLED FIELD ANALYSIS
AIM:

To determine total deformation and temperature distribution using coupled field
analysis

SOFTWARE: ANSYS

THEORY:

Given below the disc brake as shown in figure , determine the total deformation and
temperature Evolved.

MOTES|

o _-_
= I PARTS T
-@- -E- “(.J:;:LL.IT;C:"‘ [ 4 h:H:_! — |r"l.‘: r.(:' —
PROCEDURE:
Step 1 - Create Geometry
@50mm
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Creating a hole

Select and drag a face to offset it. Select and drag an edge to round it.
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RESULT & CONCLUSIONS:
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VIVA QUESTIONS:

> What do you mean by coupled analysis

> Define the boundary condition in case of disc brake?

> Differentiate between steady state and transient heat thermal analysis ?
> What is the coefficient of friction between the brake pad and brake disc ?

> Which material is used to make disc brake ?
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EXPERIMENT - 12
BUCKLING ANALYSIS OF BEAM

AlM:

To Study the deflection of a buckling.
e Eigenvalue buckling analysis

SOFTWARE: ANSYS

THEORY:
Buckling loads are critical loads where certain types of structures become unstable.

Each load has an associated buckled mode shape; this is the shape that the structure assumes

in a buckled condition. There are two primary means to perform a buckling analysis:

e Eigenvalue

Eigenvalue buckling analysis predicts the theoretical buckling strength of an ideal
elastic structure. It computes the structural eigenvalues for the given system loading
and constraints. This is known as classical Euler buckling analysis. Buckling loads for
several configurations are readily available from tabulated solutions. However, in
real-life, structural imperfections and nonlinearities prevent most real-world structures
from reaching their eigenvalue predicted buckling strength; i.e. it over-predicts the
expected buckling loads. This method is not recommended for accurate, real-world
buckling prediction analysis.

P
!

A steel beam with a 10 mm X 10 mm cross section, rigidly constrained at the bottom. The
required load to cause buckling, applied at the top-center of the beam, will be calculated.

PROCEDURE:
Eigenvalue Buckling Analysis
Preprocessing: Defining the Problem

1. Open preprocessor menu
[PREP7
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2. Give example a Title
Utility Menu > File > Change Title
[title, Eigen-Value Buckling Analysis

3. Define Keypoints
Preprocessor > Modeling > Create > Keypoints > In Active CS ...

K#,X,Y

We are going to define 2 Keypoints for this beam as given in the following
table:

Keypoints Coordinates (x,y)

1 (0,0)

2 (0,100)

4. Create Lines
Preprocessor > Modeling > Create > Lines > Lines > In Active Coord
L,1,2
Create a line joining Keypoints 1 and 2
5. Define the Type of Element
Preprocessor > Element Type > Add/Edit/Delete...
For this problem we will use the BEAM3 (Beam 2D elastic) element. This
element has 3 degrees of freedom (translation along the X and Y axes, and
rotation about the Z axis).
6. Define Real Constants
Preprocessor > Real Constants... > Add...
In the 'Real Constants for BEAM3' window, enter the following geometric
properties:
i.  Cross-sectional area AREA: 100
ii.  Area moment of inertia 1ZZ: 833.333
iii.  Total Beam Height HEIGHT: 10
This defines a beam with a height of 10 mm and a width of 10 mm.
7. Define Element Material Properties
Preprocessor > Material Props > Material Models > Structural > Linear >
Elastic > Isotropic
In the window that appears, enter the following geometric properties for steel:
i.  Young's modulus EX: 200000
ii.  Poisson's Ratio PRXY: 0.3
8. Define Mesh Size
Preprocessor > Meshing > Size Cntrls > Manual Size > Lines > All Lines...
For this example we will specify an element edge length of 10 mm (10
element divisions along the line).
9. Mesh the frame
Preprocessor > Meshing > Mesh > Lines > click 'Pick All
LMESH,ALL

Solution Phase: Assigning Loads and Solving
1. Define Analysis Type
Solution >  Analysis Type > New Analysis >  Static
ANTYPE,0
2. Activate prestress effects
To perform an eigenvalue buckling analysis, prestress effects must be activated.
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You must first ensure that you are looking at the unabridged solution menu so
that you can select Analysis Options in the Analysis Type submenu. The last
option in the solution menu will either be 'Unabridged menu' (which means
you are currently looking at the abridged version) or 'Abriged Menu' (which
means you are looking at the unabridged menu). If you are looking at the
abridged menu, select the unabridged version.

Select Solution > Analysis Type > Analysis Options

In the following window, change the [SSTIF][PSTRES] item to 'Prestress
ON', which ensures the stress stiffness matrix is calculated. This is required in
eigenvalue buckling analysis.

m Static or Steady-State Analysis
Nealnear Options

[NLGEOM] Large deform effects [ ot

[NROPT] Newton-Raphson option | Program chosen |
Adaptive descent |OM £ necessary |

Uneas Options

[LUMPM)] Use lumped mass appeox? [~ No

[EQSLY] Equation solver {Prc-qram Chosen _'__I

Tolerance/Level -
- vald for all except Frontal and Sparse Salvers

Mutipler -
- vaid only for Precondtion CG
[PRECISION] Sngle Precison -
- vald only for Precondtion CG
[MSAVE] Memory Save -
- vakd only for Precondtion CG

[PIVCHECK] Pivots Check
- vaid only for Frontal, Sparse and PCG Solvers

[SSTIF){PSTRES]

Stress stfness of prestress
Note: ¥ NLGEOM,ON then set SSTIF,ON.

[TOFFST] Temperature diference-

- between absolute 2ero and 2ero of active temp scale

x|

,ni
Ca)ceil

_tep |

%]

3. Apply Constraints

Solution > Define Loads > Apply > Structural > Displacement > On

Keypoints

Fix Keypoint 1 (i.e. all DOF constrained).

4. Apply Loads

Solution > Define Loads > Apply > Structural > Force/Moment > On

Keypoints

The eignenvalue solver uses a unit force to determine the necessary buckling

load. Applying a load other than 1 will scale the answer by a factor of the load.

Apply a vertical (FY) point load of -1 N to the top of the beam (keypoint 2).
The applied loads and constraints should now appear as shown in the figure below.
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Eigervalee Bucklimg Analyaia

5. Solve the System
Solution > Solve > Current LS
SOLVE
6. Exit the Solution processor
Close the solution menu and click FINISH at the bottom of the Main Menu.
FINISH
Normally at this point you enter the postprocessing phase. However, with a buckling
analysis you must re-enter the solution phase and specify the buckling analysis. Be
sure to close the solution menu and re-enter it or the buckling analysis may not
function properly.
7. Define Analysis Type
Solution > Analysis Type > New Analysis > Eigen Buckling
ANTYPE,1
8. Specify Buckling Analysis Options
o Select Solution > Analysis Type > Analysis Options
o Complete the window which appears, as shown below. Select '‘Block Lanczos'
as an extraction method and extract 1 mode. The 'Block Lanczos' method is
used for large symmetric eigenvalue problems and uses the sparse matrix
solver. The 'Subspace’ method could also be used, however it tends to
converge slower as it is a more robust solver. In more complex analyses the
Block Lanczos method may not be adequate and the Subspace method would

have to be used.
[BUCOPT] Bucking Analysis Options
Method Mode extraction method
(" Subspace
(& Block Lanczos
NMODE No. of modes to extract

| 1|
SHIFT Shift pt for eigenvalue | 0
I 0

Help

LDMULTE Load multipier imit

- vaid only for Block Lanczos

OK Cancel
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9. Solve the System
Solution > Solve > Current LS
SOLVE
10. Exit the Solution processor
Close the solution menu and click FINISH at the bottom of the Main Menu.
FINISH
Again it is necessary to exit and re-enter the solution phase. This time, however, is for
an expansion pass. An expansion pass is necessary if you want to review the buckled
mode shape(s).
11. Expand the solution
o Select Solution > Analysis Type > Expansion Pass... and ensure that it is on.
You may have to select the 'Unabridged Menu' again to make this option
visible.
o Select Solution > Load Step Opts > ExpansionPass > Single Expand >
Expand Modes ...
o Complete the following window as shown to expand the first mode

[MXPAND] Expand Modes

NMODE No. of modes to expand 1

FREQB,FREQE Frequency range | 0 | 0
Elcaic Cakculate elem results? [ Ho
SIGNIF Significant Threshold
-onby vakd for SPRS and DDAM 0.001
0K Cance Help |

12. Solve the System
Solution > Solve > Current LS

SOLVE

Postprocessing: Viewing the Results
1. View the Buckling Load
To display the minimum load required to buckle the beam select General
Postproc > List Results > Detailed Summary. The value listed under
‘TIME/FREQ' is the load (41,123), which is in Newtons for this example. If
more than one mode was selected in the steps above, the corresponding loads
would be listed here as well.
/POST1
SET,LIST
2. Display the Mode Shape
o Select General Postproc > Read Results > Last Set to bring up the data for
the last mode calculated.
o Select General Postproc > Plot Results > Deformed Shape
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RESULT & CONCLUSIONS:
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VIVA QUESTIONS:
» Define Buckling .

State the Boundary Condition for buckling .

Differentiate Between Linear and non linear buckling .
Define Shell Element.

Define Solid Element

Y V V V

BE VII SEMESTER FINITE ELEMENT ANALYSIS LAB MANUAL Page 100



Methodist College of Engineering & Technology
Department of Mechanical Engineering

EXPERIMENT - 13
HARMONIC ANALYSIS OF CANTILEVER BEAM

AIM:

To Study the stress and deflection on the Cantilever Beam by using cyclic load
SOFTWARE: ANSYS

THEORY:

Conduct a harmonic forced response test by applying a cyclic load (harmonic)
at the end of the beam. The frequency of the load will be varied from 1- 100 Hz. Modulus of
elasticity = 200 GPa, Poisson’s ratio = 0.3, Density = 7800 Kg/m?®.

100 N

]
2 |
r

0/10m

O.[1 Om

1 m

PROCEDURE:
Step 1: Workbench Toolbox
Toolbox - Analysis Systems — Harmonic Response
Open Harmonic Response dialog box will appear

File View Tools Units Extensions Jobs Help

_] Lj ﬂ Lﬂ Project

|ﬂjlmport... | Reconnect Refresh Project *# Update Project | == ACT Start Page
A Bl Froject Schematic

|EI Analysis Systzms |"
{4 DesignAssessment

) Eigenvalue Buckling A A
_!g Explicit Dynamics 2 & Engineering Data v 4
Fluid Flow (CFX,

g Fluid Flnv.'((Flue)nt) 3 Q eometry 7.
] HarmonicAcoustis 4@ vodel F 4
Harmanic Response 5 a Setup F .
w 1C Engine {Fluent) 5 Solution P,
8 1C Engine (Forte) 7| @ P

o
i
=%

5 i

o

|i5) Magnetostatic
Modal

) Modal Acoustics
filj Random Vibration
Il ResponseSpectum
Bz Rigid Dynamics

In that Engineering Data open by default Structural Steel will be there
Close Engineering Data and from dialog box open Geometry
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2. Cr A m
From dialog box open Geometry

Fle View Tools Units Extensions Jobs Help

DB /EE]/ o=

| dlmport... ‘ “oReconnect |2] Refresh Project  Update Project | B8 ACT Start Page

=
Ennalysjssmms |A
Design Assessment

Eigenvalue Buckling

Electric

Explicit Dynamics

Fluid Flow (CFX)

Fluid Flow (Fluent)

Harmonic Acoustis

Harmonic Response

1C Engine (Fluent)

IC Engine (Forte)

Magnetostatic

Modal

Modal Acoustic

@ Model
.‘ Setup

2
2
§& solution 2
=

Harmonic Respanse

IEEERIEEEREE®

Select XY Plane - Sketch and make it Look at Face
Set Units as Meter

| File Create Concept Tools Units View Help

o Gheo |[sdect[y B MBE@ (v (B E[[S - QAQEA QE W46 [ LA AP AP AP AL A A Ml
- B
T
| @Edrude glaRevoive @ Sweep  § Skin/Loft
| WThio/Suface @ Blend v & Chamfer @pslice || @pPoint B Conversior
| BladeEditor: @import BGD fZ{Lo2d BGD [#]Load NDF | SPFlowPath 7 Blade of Splitter JVistaTFExport ' ExportPoints WWStageFluidZone ol SectorCut g ThroatArea ¥ CAD Import v | D Preferences
| RS = (Ei | el e@
5-o/@ A: Harmonic Response [
G o e ANSYS
“ R 2019 R2
’*ﬁ:: @ Hide Sketch ACADEMIC
8 0pars 05/ (TN
3y, Show Dependencies
X Delete
<} Generate (F5)
alb Rename (F2)

Sketch [sketent
Sketch Visibility | Show Sketch
Show Constraints? | No

0.00
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)
Model View | Print Preview
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RESULT & CONCLUSIONS:
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VIVA QUESTIONS:

» Define Harmonic Analysis ?

» What are differences between boundary value problem and initial value problem?
» How do you define two-dimensional elements?

» What is meant by plane stress analysis?

» Write a displacement function equation for CST element?
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EXPERIMENT - 14
EXPLICIT ANALYSIS OF CAR WITH 100M/S
AIM:

To determine the deformation in case of crash of a car with bumper at 100m/s

SOFTWARE: ANSYS

THEORY:
Determine the total deformation in case of car moving with velocity of 200m/s
2
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Trim Unwanted Geometry
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Give Velocity in Z Direction
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RESULT & CONCLUSIONS:
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VIVA QUESTIONS:

» Differentiate between implicit and explicit analysis ?

Define time step ?
Differentiate between preprocessor vs postprocessor ?

Define Hourglass?

YV V V VY

What are the different post processor available for explicit analysis in
ANSYS?
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EXPERIMENT - 15
FLOW ANALYSIS OF PIPES WITH DIFFERENT FLUIDS/GASSES/AIR

AlM:
To analyze the velocity and pressure gradients within a pipe by using different fluids, gases,
and air.

SOFTWARE: SolidWorks (Flow Simulation)

THEORY:
In fluid dynamics, the flow of different fluids, gases, and air through a pipe results in
distinct velocity and pressure gradients due to variations in density, viscosity, and
compressibility. These gradients are crucial in determining the efficiency of fluid
transport in pipes, affecting factors like energy losses and flow stability. Analyzing
these parameters helps optimize pipe design for specific applications, ensuring efficient
and effective fluid flow.

PROCEDURE:
e Create a geometry in part modeling
Add flow simulation from add ins

Create a lids to openings

Check the geometry — analysis type is internal
Open Wizard from command manager
Project name — duct

Select SI Units

Pressure in bar

Temperature in °C

Gravity Y= -9.81m/s?

Temp 20°C

Finished

e Computational Domain

» 3D Domain

» Hide computational domain

VVVVVYVYY
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e Boundary Condition

Select the Face Lid of Inlet

Apply inlet volume flow rate 0.25
Select the Face Lid of first outlet
Apply Environment Pressure
Select the Face Lid of second outlet
Apply Environment Pressure
Select the Face Lid of third outlet
Apply Environment Pressure

[

)

S
VVVZVVYVVYVYYYY

Surface Goals mass flow rate first outlet
Surface Goals volume flow rate second outlet
Surface Goals mass flow rate third outlet

e Run the project
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RESULT & CONCLUSIONS:
e Result
» Velocity
> Pressure
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VIVA QUESTIONS:

» What factors influence the velocity and pressure gradients in a pipe flow?
» How does fluid viscosity affect the flow characteristics within a pipe?

» Can you explain the difference between laminar and turbulent flow in the
context of pipe flow?

» Why is it important to study the flow of different fluids or gases in the same
pipe?

» How do changes in fluid density impact the pressure distribution along the
pipe?

» What role does the Reynolds number play in determining the flow regime
within a pipe?

» How can the results of this experiment be applied to real-world industrial
applications?
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